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Constructing a Model Portfolio

In this exercise guide, you will learn how to leverage some of the key features in

Morningstar Direct, including the following tasks:

Overview

Mamingats [

=™ | P D DRI

My Portfolio

e Build your own portfolio from an Investment List
¢ Modify an existing portfolio

e How to handle Cash positions

Eile New Faworites Tools Reports Help @ Search for In This View ~ Go

Send us feedback

Model Portfolio

= General Settings Action - | View Snapshot - Portfolio 16/03/2017 ~

E= Imported Price/Return
= Holdings Summary

& Import 4} Export~ | 5% Edit Data | [K] PDF 4 Refresh

r Name s EI‘;:)lght
Benchmark:My Benchmark

r: AXA Rosenberg Pan-Erup Eq Alpha A EURACT 12.50
2 BGF Global Allocation A2 15.00
s Candriam Sust Pacific C JPY Cap 12.50
ra CASH EUR 5.00
rs Fidelity Special Situations 10.00
s Invesco Euro Equity A EUR Acc 10.00
rz Invesco Pan Eurp Struct Rspnb Eq EEURACC 15.00
s iShares STOXX Global Sel Div 100 (DE) 12.50
o Robeco High Yield Bonds DH € 7.50

Edit -

Price Source

Morningstar Pri
Morningstar Pri
Morningstar Pri
Imported Price]
Morningstar Pri
Morningstar Pri
Morningstar Pri
Morningstar Prf

Morningstar Pri
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Chart View Growth 10K v  Initial Value 10,000

View WESEEREN Data Teble

ScaleLog v

Source Data Default v |Event v TaxMethod Pre-tax v Currency Euro v
13K
121K
116K
10,8
10,1k
57K
2016 2017 2018 2019 2020
*|201s 2017 2018 2018 2020
Investment Name Value
— My Partolic (Total Return, EUR, Pre-Tax) 115K My Benchmark (Total Return, EUR, Pre-Tax)

Reset

Farkbs®  Bumhe

12.54K

Btk s
Bl

=

EZED2 t OO0R e §

ecuriting

nd 0
nd Cash Equivalents M5
1

']

[e—

Risk-Froe Rom
Eurbor ] Marth BUR

Garancy

BR

Banchmart
My Barc

Fortfolio Statistics

Price/Frospec

335

422

8
428 i
10000

s e a1 e by caciin e ey T vt e e 1] ot s Mg
. carate -

e = o
P, ot s st o s e o i e by i e i, Pt i e s gt of

MORNINGSTAR™

MORNINGSTAR

Mornings

tar Direct 2021

© 2020 Morningstar. All Rights Reserved.



Constructing a Multi-Manager Portfolio

Exercise 1: Creating a Model Portfolio

The first step in creating a portfolio is to identify its investments. Once you have gone
through your selection process, you can save those investments in an Investment
List for easy access.

There are 3 main sections in Portfolio Management: Model Portfolios (for your
portfolios, Custom Benchmarks (for mixed indices), and Accounts (for returns series
or holdings import). The process for creating either item is similar.

We will be working with the Model Portfolios section. To create a new Model
Portfolio, do the following:

1. In Morningstar Direct, select the Portfolio Management tab. The Accounts section is
selected by default.

2. Click on Model Portfolios.

3. From the toolbar, click New. The Model Portfolio Basics window opens.

File New Favorites Tools Help Pr\:e Monitor Search for
Home
Equity/Credit Research i Action 'M&‘ Import [ view 1mp)
Local Databases r Name Be sure to select
Global Databases the correct tab and

icon

Performance Reporting

Asset Allocation

Portfolio Management
i Strategies
E Model Portfolios
[ Custom Benchmarks

B Accounts

Exercise 1: Creating a Model
Portfolio
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Constructing a Multi-Manager Portfolio

Exercise 1: Creating a Model Portfolio

4. Under Name, type “My Portfolio”.

ol

Using the Currency drop-down menu, select Euro (or the currency of your choice).

6. Under Risk Free Proxy, set the risk-free rate of your choice using the magnifying

glass.

7. Under Portfolio ID, type “Portfolio123".

(oo

Under Rebalancing frequency, select Monthly.
Under Performance calculation start date, select First Portfolio Date.

Name

Combined series

Combined series:Yes

Ease series
Operator

Second series

Combined series:No

Currency

Benchmark 1
Benchmark 2

Rizk free prosxy
Portfolio ID

Performance source

Management fee
effective period

Management fee %

My Portfolio

Oves ®No
@
[
@
Euro

]

MSCI Europe NR EUR

MSCI World NR EUR

[@)
[@)

Euribor 3 Month EUR

Portfolio123

@

Calculated based on underlying positions ﬂ

Entire period

[v]

Enter/select information
as appropriate

Fee applied™ Annually
Performance series l]
Rebalancing frequency | Monthly ll
Rebalancing based on Calendar Period End
Performance . -
calculation start date |Flr't Portfolic Date

M( )HNINGSTAH Marningstar Direct 2021
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Constructing a Model Portfolio Exercise 1: Creating a Model Portfolio

10. Choose your rebalancing frequency. In this exercise, we will use the information in beld.

Rebalancing Rebalancing based on  Performance Calculation Missing TNA
Frequency Start Date Handling
Buy and Hold | - Enter the date of those positions
in the Holdings Entry dialogue
box
Monthly/Daily| Calendar Period End: on First Portfolio Date: select
/Quarterly/ the end period date (E.g; | specific date
Semi- month end if monthly if | E4pfiest Available: date of the
Annually/Ann | monthly is selected) inception date of the oldest
ually Rolling Period based on | constituent
Portfolio Date: on the Earliest Common: common
same day in the next period
period
Monthly — - - Infer forward in time
Total Net Infer backward in time
Assets .
Roll previous value
forward
Buy and Hold | - - Infer forward in time
— Total Net Infer backward in time
Assets .
Roll previous value
forward

@ Note: Rebalancing with Monthly — Total Net Assets means the portfolio is rebalanced
each month in proportion to the TNAs of the share classes as of that month end.

& Note: Rebalancing with Buy and Hold — Total Net Assets means the weightings are
automatically updated as the latest month end date changes.

11. Click Save. The Holdings Entry dialogue box opens.

< Note: Regarding benchmarks: you have access to the Market Indexes database, as
well as access to Morningstar Indices.

< Note: As mentioned earlier on in this document, Portfolio Management also allows
you to create your own Custom Benchmarks. You can therefore go to Portfolio
Management > Custom Benchmarks and create your own mixed index, following
the same instructions as to create a Model Portfolio.

MOHMNBSTAH Morningstar Direct 2021
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Constructing a Model Portfolio Exercise 2: Selecting Constituents from an existing Investment List

You are now able to select the investments for your Model Portfolio. You can select Exercise 2: Selecting
investments from an existing Investment List, or simply select your funds by looking Constituents from an
for their ISIN or Secld. existing Investment List

< Note: It is recommended to use Secld (unique identifier) when working with
investments such as ETFs or currency share classes that have the same ISIN as
identifier.

There are three main tabs in the Holdings Entry dialogue box:

» Stock/Fund: select from the Stocks and Funds databases
» Fixed Income: select from the Bonds database
» Cash: select custom cash securities (set up in Security Definition Master)

To select investments, do the following:
1. Under the Stock/Fund tab, click Add. The Add Holdings dialogue box opens.

Holdings Entry - Marningstar Direct =3 R

Assign weights (o the members of your model portfolio by buping
rter By Action meru

Position as of |311220% Use Earliest Common Date
StockFund ]

ction | etr oy~ [E0] @ Rt prcs | B8t DatrtonMastr | UR S, Tt Aot 100000 Total Wit 10000 Click here to select
e Name InceptionDate R Number of Shares  EUREqu Investments
e

o
VESSPPLELLES

Feedback Equal Weight Eirizko >

i

2. At the top of the dialogue box, select the My Lists radio button.

@ Note: You can also select Universes and access the Morningstar databases, or My
Searches and access your saved Search Criteria.

Add Holdings X
Within O Universes @ My Lists (O My Searches
” “portfolio List V“
Find By Name ~| @Begins with (O Contains
A nclude Only Surviving Investments Select your
\ [ e Investment List and
Asable Records click Go

Total records: 8

Jump to record name: |

|AXA Rosenberg Pan-Erup Eq Alpha A EURACc (EUR,IED008365730, Port+Perf,Repl A
BGF Global Allocation A2 (EUR,LUD171283459,Port+Perf)

Candriam Sust Pacific C JPY Cap (JPY,BE0174191768,Port+Perf,RepPerf)

Fidelity Special Situations (GBR.GB0003875100,Port+Perf,RepPerf)

Invesco Euro Equity A EUR Acc (EUR,LU1240328812, Port+Perf,RepPerf) v
< >

Click on Add Al to
Sol e select all investments
Total records: &

Invesco Eure Equity A EUR Acc (EUR,LU1240328812,Port+Perf,RepPerf) "
Invesco Pan Eurp Struct Rspnb Eq EEURAce (EUR,LUD194781224, Port+Perf,RepP:
iShares STOXX Global Sel Div 100 (DE) (EUR,XETR,ISPA, Port+Perf,RepPerf)
Robeco High Yield Bonds DH € (EUR,LU0085136942,Port+Perf,RepPerf)

& < ¥ B

v
< 3

Remaove Remave All

o Corce

3. Click OK to close the dialogue box.

MmHNmGSTAH Morningstar Direct 2021
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Constructing a Multi-Manager Portfolio Exercise 3: Creating a Custom Cash Position

Back on the Holdings Entry dialogue box, we want to add some cash to our portfolio.
But we first need to create the cash position in Security Definition Master in order for it
to be recognised in the right currency.

To create a cash position, do the following:

1. From the Holdings Entry window, click the Cash tab.
2. Click Edit Definition Master. The Definition Master window opens on screen.
3. From the toolbar, click Security Wizard.

: File Help @ Search for 1n This View * Go B Send us feedback

Definition Master

+ &5 User Defined Securities | - Actmn‘l = Security Wizard k: Add Rows 8 Import @ Save | i Export~ | @ Print g Refresh

~E= Customized Data
E Security Types

< >
Al = A B CDEF G H I J K LMNOPQGQRZSESTUWV WX Y Z
Total: 2 B/ Selected: 0

4. Under Security Type, select Cash and Cash equivalents.
In the Description, CUSIP, ISIN, and Symbol fields, type Cash EUR.
6. Under Base Currency, select Euro Member Countries, Euro.

[Sal

Morningstar Direct — O X
| oasic |
Eecurity Type® Cash and Cash Equivalents = ISW”"“" Cash EUR| x
kuse Cash EUR
SIN Cash EUR 1092 Reporting Select v
Category
bescription Cash EUR

Last Update Date

Attributes

Asset Class [¥] sector Not Classified = Enter the
ndustry Not Ciassified - information as
shown here
Region and Currency
Exchange Not Classified |  cCountry of Origin United States v
Country United States v Base Currency Eurc Member Countries, Euro |w
Notes(200 characters max)
Help Save + New Save + Close Save Close

7. Click Save + Close and click OK on the prompt.

Exercise 3: Creating a
Custom Cash Position

= Securities r Name a Security Type Symbol cusie Sec Sourceld o o

E Security Mappings Click Security
~&= Morningstar Securities i

H Price Sources ra Cash CHF Cash and Cas  CASH CHF CASH CHF Wizard

= Reclassification 2 Cash GBP Cash and Cas  CASH GBP CASH GBP

MOHN'NGSTAH Morningstar Direct 2021
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Constructing a Multi-Manager Portfolio

Exercise 3: Creating a Custom Cash Position

You are returned to the Definition Master window.

Note the new Cash position in Euro currency.

Definition Master

: File Help Search for In This View ~* Go % Send us feedback

a

E Securities r Name 4 Security Type Symbol cusIP
= Security Mappings
~&8 Morningstar Securities

¥ &8 User Defined Securities | - Action~ i Security Wizard [ Add Rows & Tmport B Save | i} Export- | @i Print ¢ Refresh

Sec Sourceld

B Price Sources 1 Cash CHF Cash and Cas  CASH CHF CASH CHF
B Redlassification |r 2 Cash EUR Cashand Cas  CASH EUR CASH EUR
~&5 Customized Data T Tash GBP Tashand Cas  CASH GBP CAEH GEP

E Security Types

<

Total: 3 BV Selected: 0

Al = A B CDEGFGHTIIKLMNOEPRQRSTUVYVWXY Z

Close the window ta return to the Holdings Entry window.
Click Add. The Add Holdings dialogue box opens.

In the Search field, type cash eur, click Go.

Select your custom cash and click Add.

— — O
—_ o

Within [user Defined cash ~|
Find By Name ~| @ Begins with (O Contains
[ 1nclude only Surviving Investments
[}
|| cash eur | Go |
Available Records
Total records: 1
Jump to record name: | cash eur
Cash EUR (CASH EUR,CASH EUR,CSH,Unknown)
£ >
Add Add All
Selected Records
Total records: 1
Cash EUR (CASH EUR,CASH EUR,CSH,Unknown) ES
~
v
Remove Remove All
Help QK Cancel

12. Click OK.

Add your
cash
position

MmHmNGSTAH Morningstar Direct 2021

© 2020 Morningstar. All Rights Reserved.



Constructing a Model Portfolio

Exercise 4: Assigning Weights to your Pasitions

Back in the Holdings Entry window, we can now allocate weights to our positions.

1. Assign 5% to your cash.

Exercise 4: Assigning
Weights to your Positions

Heldings Entry - Morningstar Direct - a X
Holdings Entry
Use the tabs to enter holdings for 5 model portfolio. The default entry rethod is percertage. Assign weights ta the members of your madel portfolio by typing values inta the percent
column. “You can choose to enter by Shares or by &mount from the Enter By Action menu.
Postion s o
: Action~ | Enter By~ + Add | & Edit Definition Master EUR Equiv. Total Amount: 10,000.0C Total Weight: 5.00
D Mame [F.’/E]IGEHI ;UR Equivalent Amount inBase Base Currenc:
(mEl |[C=shETH 5.00 | 500,00 EUR ~
B I
Os LY
Oe a
Os LY
Os a
m LY
Os a
Os LY
Own a
= 3 .
Feedback Equal Weight Finishi > Cancel Help
2. Click the Stock/Fund tab.
3. Assign the following weights to the remaining holdings:
AXA Rosenberg Pan-Eurp Eq Alp A EUR 12.5
BGF Global Allocation A2 10
Candriam Sust Pacific C Acc 15
Fidelity Special Situations 10
Invesco Euro Equity A EUR Acc 125
Invesco European Growth Equity E 10
iShares STOXX Global Sel Div 100 (DE) 15
Robeco High Yield Bonds DH EUR 10
Cash EUR 5
MOORNINGSTAR Morningstar Direct 2021 12
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Constructing a Model Portfolio

Exercise 4: Assigning Weights to your Pasitions

4. Using the calendar next to Position as of, set the date to 01/01/2016.

Holdings Entry
Use the tabs to enter holdings for a model potfoiio. The default entry method s percentage. Assign weights to the members of your model portfolio by typing values into the percent
calumn, You can choase to enter by Shares or by Amount from the Enter By Aetion menu
Stock/Fund
Action = | Enter By ~| + Add | @ Refresh Price [H Edit Definition Master | EUR Equiv. Total Amount: 10,000.0C Total Weight: 100.00
0 Symbel Name. InceptionDate | HumberofShares | EUREqy
Amount
O @, Invesco Euo Equity & EUR Ace 02/10/2015 11.37 1ia
Oz 15PA @, iShares 5TOX Global Sel Div 100 [DE] 26/08/2008 57.83 18
Os @, Invesco Pan Ewip Stuct Repnb Eq EEURAce 30/08/2004 4371 1
e @, Candiiam Sust Pacific CJPY Cap 15/08/2000 5315 18
Os @, £X4 Rosenberg FanErup Eq Alphs & EURce 30/09/1993 7645 14
Os @, Rabeco High Yield Bands DH € 17/04/1993 817 1
O @, BGF Global Allocation A2 03/01/1997 2218 10
Os @, Fidelty Special Situations 1741211979 2374 10
Os a,
Own a
an o v
< >
Feedback Equal Weight Einisho> Cancel Help

Enter weights and
set the date to
01/01/2016

< Note: You can enter positions by weight, amount or number of shares. To do so,

click Enter By and select the appropriate option.
1. Click Finish.

Your portfolio is now saved and opens on screen.

Eile MNew Favorites Jools Reports Help Search for In This View - Go
Send us feedback
Model Portfolio
E General Settings Action ~ | View Snapshot ~ Portfolie 01/01/2016 ~ Edit +
» B Imported Price/Return

— I rt Export ~ Edit Dat: PDF Refresh

= Holdings Summary & Import ) Expo it Data | K] e
r Name + Weight Price Source ISIN

(%)
Benchmark:MSCI Europe NR EUR Morningstar Price
ra AXA Rosenberg Pan-Erup Eq Alpha A EURAcc 12.50 Morningstar Price TEOC
ez BGF Global Allocation A2 10.00 Morningstar Price Luo
rs= Candriam Sust Pacific C JPY Cap 15.00 Morningstar Price BEO
ra Cash EUR 5.00 Imported Price Cas
s Fidelity Special Situations 10.00 Morningstar Price GBO
s Invesco Euro Equity A EUR Acc 12.50 Morningstar Price LUt
rz Invesco Pan Eurp Struct Rspnb Eq EEURAcc 10.00 Morningstar Price LuQ
rs iShares STOXX Global Sel Div 100 (DE) 15.00 Morningstar Price DEO
(ni] Robeco High Yield Bonds DH € 10.00 Morningstar Price Luol
< >

Al = A B CDEFGHTIJKTLMNMNOPI QRTSTUWVWIXY Z
Total: 3 By Selected: 0

Morningstar Direct 2021
© 2020 Morningstar. All Rights Reserved.

MAORNINGSTAR



Constructing a Multi-Manager Portfolio

Exercise b: Recording a Change in the Portfolio Composition

We now want to record a change in our portfolio over time. We will the

refore create Exercise 5: Recording a

a new date with the composition of the portfolio on this date and time. Change in the Portfolio
To record a change in the portfolio, do the following: Composition
1. From the toolbar in your Model Portfolio window, click on the arrow next to Edit >
New Portfolio.
My Portfalio Model - O X
File MNew Favorites Tools Reports Help Search for In This View * Go
B Send us feedback
Model Portfelio
-
B General Settings Action~ | View Snapshot - Portfolio 01/01/2016 - Edi Click i d
. ICK On the arrow an
' ; ;:E?;Zd;:::f:um & 1mport 4} Export~ | % Edit Data | [K|PDF ¥ Refresh Edit Portfalio then on New Portfolio
r Name o Weight |__New Partfolio Il =sm
(%) Remove Portfolio
Benchmark:MSCI Europe NR EUR Morningstar Price
i AYA Rosenberg Pan-Erup Eg Alpha A EURAcc 12.50 Morningstar Price IEOC
2. The Portfolio Date Selection dialogue box opens.
3. Enter the date of the change in positions allocation: 15/06/2016.
4. Select Modify Constituents from an Existing Portfolio to copy the previously selected
constituents.
5. Select Retain Weights to work with weights.
6. Choose the original portfolio date you want to work with (only one in this case).
7. Click OK.
Marningstar Direct == B
Portfolio Date Selection
Select portfolio date here.
New Portfolio Date 15/06/2016 E_.I
Create Blank Portfolic o] Use the h|gh||gh‘[ed
I Modify Constituents from an Existing Portfolio [ ] I Optlons
O Retain Shares Include Corporate Actions O
I 02/10/2015 [v] I
Ok Cancel
MOORNINGSTAR Morningstar Direct 2021 14
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Constructing a Model Portfolio

Exercise 5: Recording a Change in the Portfolio Composition

You are taken back to the Holdings Entry dialogue box. We want to remove the last
security from our portfolio.

8. Tick the checkbox next to the name of the last security in your list.
9. Go to Action > Delete Rows.

Holdings Entry

Use the tabs to enter holdings for a model portfolio. The default entry method is percentage. Assign weights to the members of pour model portfolio by typing walues into the percel

column. You can choose to enter by Shares or by Amount from the Enter By Action menu

Position as of | 16/08/2016 [ERd

Stock/Fund

;Enter By~ | + Add e Refresh Price | [ Edit Definition Master | EUR Equiv. Total Amount: 10,000.0C Total Weight: 100.00

r Add Rows Mame Inception Date Percent Mumber of Shares  EUREqu

Delete Rows ) Spen
[, Add Multiple @, A4 Rosenbiera Pan-Erup Eq Alpha & ELIRASe 30/09/1299 1250 B5.03 1im
Oz @, BGF Global Allooation 42 03/01/1997 1000 2314 10
s @, Candriam Sust Pacific C.JPY Cap 15/09/2000 156.00 65.53 1.
(mE? @, Fidelity §pecial Situations 171241973 10,00 26.58 1.0
Os @, Invesco Euro Equity & EUR Acc 02/10/2015 1250 127 1.2
Os % Invezco Pan Eurp Stuct Rspnb Eq EEUIRAC: 3070642004 10.00 47 96 il
(mE 15P4, &, Bhaes ST Global Sel Div 100 [DE) 25/05/2009 15.00 59.43 iH
g &, Robeco High ‘vield Bonds DH £ 17/04/1338 10,00 763 1.4
0 Y

10. Assign 15% to Fidelity Special Situations and BGF Global Allocation A2.
11. Click Finish.

The change in portfolio composition has now been recorded. You can use the Portfolio
drop-down menu to toggle between the dates.

Model Portfolio

E General Settings
» B5 Imported Price/Return
E Holdings Summary

Action = | View Snapshot

& Import ‘Q Export ~
r Name

5% Edit Data

- | Portfolio | MERSEIGLE |~
15,/06/2016 |
[E] PDF| @ Refreso1,01/2016

Benchmark:MSCI Europe MR EUR

| AXA Rosenberg Pan-Erup Eg Alpha A EURACC
2 BGF Global Allocation A2
3 Candriam Sust Pacific C IPY Cap

4 Weight
(%)

12.50
15.00
15.00

Edit -

Price Source

Morningstar Price

Morningstar Price
Maorningstar Price
Morningstar Price

ISIN

IEOC
LU
BED

Close the Model Portfolio window by clicking on the red cross in the top-right corner.

You are taken back the Model Portfolios section of Portfolio Management.

Use the
highlighted
options

Use this drop-down
menu to toggle
between dates

MAORNINGSTAR
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Constructing a Model Portfolio

Exercise 6: Creating a Custom Benchmark

We want to assign a mixed benchmark to this model portfolio. To do that, we first need
to create it. The steps are the same as when you create a Model Portfolio, but you

would do so in the Customer Benchmarks section.

To create a Custom Benchmark, do the following:

1. From the Portfolio Management section in the Navigation panel, click Custom

Benchmarks.

Under Name, type “My Benchmark”.
Set the Currency to Euro.

SO W™

Common.

~

Click New. The Benchmarks Basics window opens.

Click Save. The Holdings Entry window opens.

8.  Click Add and select the following indices and weights:

Using the Rebalancing frequency drop-down menu, select Monthly.
Using the Performance calculation start date drop-down menu, select Earliest

Exercise 6: Creating a
Custom Benchmark

Benchmark Secld Weights %
Cat 50%Barclays US Agg TR&50%FTSE WId TR | XIUSAQ4GT8 15
FTSE AlISh TR GBP XIUSA04CGI 10
ICE BofA Gbl HY Constnd TR HEUR FOUSAO6W37 20
MSCI AC Asia Pacific NR USD XIUSAO4EW7 10
MSCI Europe Large NR EUR FOO0O00UXON 35
MSCI World High Dividend Yield NR USD FOUSA06079 10

Eosition asof |05/06/2007 [+

Stock/Fund

Action~ | Enter By~ | 4 Add @ Refresh Price | F Edit Definition Master

EUR Equiv. Total Amount: 10,000.

| Symbal Mame Inception Date Percent
[
O+ @, Cat 50%Barclays S Aagg TRESDZFTSE WwWid TR 311241993 15.00
Oe= &, FTSE &15h TR GBP 3121985 10.00
Os &, ICE Bofd Ghbl HY Constnd TR HELIR 3NA21997 20.00
O &, MSCI AL Asia Pacific NR ISD 3121998 10.00
Os % MSCl Evrope Large MR EUR 05/06/2007 35.00
Os @, M5Cl waorld High Dividend ield NR USD NA0/2008 1000
— &
9. Click Finish.

Your Custom Benchmark is saved. We can now assign it to the Model Portfolio we

created.

MAORNINGSTAR
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Constructing a Model Portfolio Exercise 7: Assigning a Custom Benchmark to a Model Portfolio

Assigning a Custom Benchmark to a Model Portfolio will ensure this both will display in  Exercise 7: Assigning a
Interactive Desktop charts and report generated from the Portfolio Management Custom Benchmark to a
module. Model Portfolio

To assign a Custom Benchmark to a Model Portfolio, do the following:

1. From the Portfolio Management section, click Model Portfolios.

2. Double-click on the Model Portfolio labelled “My Portfolio” to open it.

3. Click General Settings on the left navigation panel.

4. Under Benchmark 1, click the magnifying glass. The Select Benchmark window
opens.

5. Using the drop-down menu, select Custom Benchmarks.

6. Click Go.

7. Select “My Benchmark”.

8. Click OK.

9. Scroll down and click Save.

The Custom Benchmark is now assigned to the Model Portfolio.

MName My Portfolio
Combined series Oves @No

Combined series:Yes

Base series ﬂ
Cperator l
Second series ﬂ
Combined series:No

Currency Eura ﬂ
Benchmark 1 My Benchmark ﬂ

MAOORNINGSTAR Morningstar Direct 2021 17
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Constructing a Model Portfolio Exercise 8: Generating a Growth Chart

We now want to see how this portfolio fairs against its benchmark in a growth chart. Exercise 8: Generating a

) Growth chart
To do so, do the following:

1. Tick the checkbox next to the portfolio you created.
2. Go to Action > Interactive Charts > Desktop-based Charts > Growth.

' New J& Import ﬁ‘JiEW’ Import Job Results @ Export~ | [&] PDF | @ Refresh

r Save As » Cremer Permission Last Up)
Add To 4

™ ulie itjean-Fre: ea rite 4
Delete Julie Pet F Read/Writ 08/03/
View Holdings 3
Reports 3

I Interactive Charts > Desktop-based Charts _ » I Caorrelation Matrix
Presentation Studio Charts 4 Web-based Charts 4 I Growth
X-Ray Return Bar
Performance Attribution » Return vs Category
Portfolio Analysis Risk/Reward
Send To 4 Rolling Return (Bar)
Share With 4 Rolling Return (Line)
Assign to Folder
My Templates...

The Growth chart displays your portfolio as well as the benchmark you selected.
Various options are available to customise the data, such as Chart View, Initial Value,
Time Range, Currency, etc.

lomingstar Direct --Mew Chart — [m] x

S Fila Tools Help - fNew H]cClipboard [H PowerPoint [E] Create PDF  iF Export Excel [ Save - & Send us feedback

Please note: Microsoft® Silverlight™™ enabled charts will be retired in Q3 2021.

Try New Chart
To learn more about the new web-based interactive charts, please click here. !

Charts = E Edit Investments Wiew “ Data Table
Add Investment Reset
Chart View Growth 10K v Initial Value 10,000 Time Range Max Time v| Mov 3, 2015 - Mar 6, 2021 Scale Log v
Source Data Default v  Event v Tax Method Pre-tax v Currency Eurc -
13K
12.1K
11.6K
10.8K
101
8.7K
2018 2017 2018 2013 2020
" 2015 2017 2018 2019 2020 |2uzi‘
[ |
Investment Name Value
| = My Portfolic {Total Return, EUR, Pre-Tax) 119K — My Benchmark (Total Return, EUR, Pre-Tax) 12,34K I

Note how both the Model Portfolio and its assigned Custom Benchmark are displayed
on the chart.

MAORNINGSTAR Morningstar Direct 2021 18
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Constructing a Model Portfolio

Exercise 9: Generating the Portfolio Aggregation report

You can easily generate a report for further quick analysis of your Model Portfolio. This Exercis_e 9 Genera_ting the
report will give an overview of the portfolio exposure, risk and return, as well as the top  Portfolio Aggregation report
25 stocks within your portfolio.

To generate this report, do the following:

1. From Portfolio Management > Model Portfolios, tick the checkbox next to your
portfolio name.
2. (o to Action > Reports > Portfolio Aggregation.

Morningstar Dim

File MNew Favorites Tools Help ;Price Mcl-nitor;

Home
Equity/Credit Research
Local Databases
Global Databases
Performance Reporting
Asset Allocation
Portfolic Management

E Strategies

E Model Portfalios

E Custom Benchmarks

H Accounts

E Account Groups

H Securities Invested
[ Saved Reports

kd New § Import

r Save As
Add To

“iew Holdings

Search for

In This View

View Import Job Results ﬁ Export -
» « Owmer

Julie Petitjea

Delete
I

Reports ’ Paortfolio Aggregation
Charts 4 HE Style Consistency
X-Ray Investment Summary

Performance Attribution
Portfolio Analysis

Send To

Share With

Assign to Folder

4 Performance Evaluation
RE Style Analysis

My Templates...

Select the Portfolio
Aggregation report

The Portfolio Aggregation dialogue box opens. You will notice how the relevant
Benchmark, Risk-Free rate and Currency assigned to the portfolio are selected.
You may decide to add a summary page for each constituent of your portfolio from
the Append constituent summary page drop-down menu.

You can also select partial or all sections of the report.

3. Leave all options as shown in the screenshot below and click OK.
4. Click No on the prompt.

Report Settings
Aggregate My Portfolio Find
Benchmari My Bendhmart [ end | The Benchmark, Risk-Free rate
and Currency settings are
nisk-free rate Euribar 3 Month ELR Find automatically filled in
[Currency Eurg ~
Append constituent
Ty pags — = 4 Choose which
Feport Content [+] &l Sections [ Portfolio information to dlsplay
Performance /Risk
Holdings
[ Constituents
Save | oK Cancel Help
MOORNINGSTAR Morningstar Direct 2021 19
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Constructing a Model Portfolio

Exercise 9: Generating the Portfolio Aggregation report

The Portfolio Aggregation report opens. You can save it by clicking on the Save

icon that appears when havering on the top of the page.

Sawe this report to the Saved Reports area in order to access it later from any location. To e-mail this report directly from this screen, click the E-mail button.

Report Title
Save Download Close E-mail Feedback Help
Warmingster Dirsct™ | Print Dts: 0B/G/2021 Page 1 of5
My Portfolio eve s comy)

H H Data as of Currency Risk-Free Rate Benchmark
Portfolio Aggregatlon 28/02/2021 EUR Euribar 3 Manth EUR Wy Beanchmark
Equity Style Box Top 10 Constituents
- Style Broakdawn Portilio % Benchmark % % Weighting
5 Lange Vil 25,96 906 1 Invesoo Pan Eup Struct Rspb Eq EEURAC 15.00

Largs Core 3024 4408 2 BGF Global Allocation AZ 1500
- Large Growth 1475 18.30 3 AXA Rosenberg Pan-Erup Eq Alpha A EURACT 1250
& b N 4 Candriam Sust Pacific C JPY Cap 1250
L] Mid Value 1197 3.00 o
5 (770} o 0 Mid Core 239 331 5 iShares STOXX Glabal Sel Div 100 (DE) 2.50
Mid Growth 198 129 6 Fidelity Special Situations. 10.00
= q
= Small Value 268 0.40 7 Invesco Eura E.qu\tr AEUR Acc 0 {JU
o Small Core 138 045 8 Robeco High Yield Bonds DH € 750
- Small Growth 056 p2n 9 CASHERR 500
5 Large Czp 70.25 9145
" 29,78 5
Mid-Small Cap 2975 B85S Portfolic
£ Value ./ 3236 Style Bax Value Factars Forsiala Banchmark
= 0 Core 2.0 4784 Price/Prospective Eamings 1518 1556
Growth 17.29 1979 Price/Book 164 182
P - . © Futic @ Portiio Constiweres. A Benchenark Price/Sales 122 1.48
DeepVdie CorsVae  Blend Core Growih igh Growth i i Constitierts erchman Prca/Cash Flow 089 64
Dividend Yield % 288 269
Style Bax Growth Factars
Portfolio Dverview Long-Term Ezming Growth % BE1 1153
Composition Portilia % Banchmark % Equity Sactor Braakdown Patioiin®  Benchmark % Historical Earnings Growth % 1.79 212
H H Cash .72 0.00 A s 20 00 aced Book Value Growth % 146 0.66

Hover at the top of the
page to save the report
to your computer

MAORNINGSTAR
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Constructing a Model Portfolio

Exercise 10: Using the Import function

An Import function is also available for Model Portfolios. This function can save you
a tremendous amount of time in creating new Model Portfolios or updating existing

ones. We are going to record additional changes over time for our current Model
Portfolio.

To do so, you need to create an Excel file with the following information:

>

vvyvyyvyy

Date — date of the positions
Portfolio Name — name of your portfolio
Portfolio ID — identifier you entered under General Settings
Identifier — constituent’s identifier

Holdings — constituent’s name

Weight (%) — percentage of the position

< Note: You can also work with Number of Shares/Amounts instead of Weights.

Date

Portfolio Name Portfolio ID

Identifier

Exercise 10: Using the Import

function

21/09/2016|My Portfolio Portfolio123|IEC008365730 |AXA Rosenberg Pan-Eurp Eq Alp AEUR | 15.00) ——
21/09/2016|My Portfolio | Portfolio123|LU0171283459 |BGF Global Allocation A2 750 Ty p—
21/09/2016|My Portfolioc  |Portfolio123|BED174191768 |Candriam Sust Pacific C Acc 15.00 and Portfolio ID
21/09/2016|My Portfolio  |Portfolio? 23 |GBO003875100 | Fidelity Special Situations 10.00 ensure the correct
21/09/2016|My Portfolio | Portfolio123|LU1240328812 |Invesco Euro Equity A EUR Acc 1250 ﬁﬁ%iiﬁ‘””“"" Is
21/09/2016|My Portfolio Portfolio123|LU0D194781224 |Invesco European Growth Equity E 1250
21/09/2016|My Portfolio  |Portfolio23 | DEDDDADFSUH1 |iShares STOXX Global Sel Div 100 (DE) | 1250
21/09/2016|My Portfolio  |Portfolio23 |LUDDB5136942 |Robeca High Yield Bonds DH EUR 750
21/09/2016|My Portfolio  |Portfolio123|Cash EUR Cash EUR 150 —
16/03/2017 |My Porifolio Portfolio123|IE0008365730 |AXA Rosenberg Pan-Eurp Eq Alp AEUR | 1250
16/03/2017 My Portfolio  |Portfolio123|LU0171283459 |BGF Global Allocation A2 15.00
16/03/2017 |My Portfolio Portfolio123|BEO174191768 |Candriam Sust Pacific C Acc 1250 Note the various
16/03/2017 |My Portfolio  |Portfolio123| GBODO3875100 |Fidelity Special Situations 10.00 i Dneting 2
16/03/2017 |My Portfalio Portfolin123|LU1240328812 (Invesco Euro Equity A EUR Acc 1000 changes in our
16/03/2017 | My Portfolio Portfolio123|LUD194781224 (Invesco European Growth Equity B 15.00 portfolio
16/03/2017 My Portfolio  |Portfolio123 | DEDDOAOFSUHT [iShares STOXX Global Sel Div 100 (DE) | 1250
16/03/2017 My Portfolio  |Portfolio123 | LUODB5 136942 |Robeco High Yield Bonds DH EUR 750
16/03/2017 |My Portfolio  |Portfolio123|Cash EUR CashEUR 500 |
The file contains positions for the same portfolio, but with two different dates,
which indicates a change in the positions on two different occasions.
To proceed with the import, do the following:
1. Download the file used in this exercise by clicking here.
2. From the Portfolio Management module under the Model Portfolios section,
click Import.
I Morningstar Direct
File Mew Favorites Tools Help Search for ‘ In This View - Go B Sen

Home
Equity/ Credit Research
Local Databases

Global Databases

Asset Allocation

E Strategies
» E5 Model Fortfolios
» B8 Custom Benchmarks

r

Performance Reporting r:

Portfolic Management

Actiun'| New

Name

My Portfolio

& Import [

View Import Job Results | @ Export= | [%] PDF | @ Refresh

& Owmer Permission

test benelux Read/Write

Click on Import
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https://advisor.morningstar.com/AWSOE/Training/PortfolioManagement/ModelPortfolioImport_EMEA.xlsx

Constructing a Multi-Manager Portfolio

Exercise 10: Using the Import function

©w o~

From the Import window, double-click on Model Portfolio Holdings. The Model

Portfolio Holdings dialogue box opens.
File Name: browse to select your saved Excel file.
Date format: select the relevant format.
Weight format: in this example, we will select Percentage Format.
Security ID Type can be left on Auto Detect.

Header Row checkbox: leave it selected if your Excel file contains a header row.

Map the Column Code with the Column No. columns.

Model Portfolio Holdings

Maodel Portfolio Holdings

File Mame | C:\Users\jpetitj\DesktopModel Portfolio import. xdsx @%
Date Format DDMM Y'Y e Weight Format Percentage Form: ~
Security ID Type Auto Detect -

Header Row

Available Templates

Column Code

Column No.

Portfolio Date

Column & (Date)

Portfolio Id

Column C (Portfolio ID)

Portfolio Name

Column B (Portfolio Name)

Holding Identifier

Column D (Identifier)

Haolding Description

Column E (Holdings)

Select your file and any
relevant settings

Click on the relevant
row in the right column
and a drop-down menu

© 2020 Morningstar. All Rights Reserved.

Share Select... opens to map items
Price Select...

Market Value Select...

Coupon Select...

Maturity Date Select...

Currency Select...

Weight Column F (Weight (%)) J

Import Cancel
10. Click on Import and the Blotter opens.
MOORNINGSTAR Morningstar Direct 2021 22



Constructing a Model Portfolio

Exercise 11: Mapping Securities

The Blotter is a temporary space where your positions are held until you validate the
information.

You will be notified of any errors or inconsistencies. In this example, a new user-
defined security is highlighted in the left panel.

To work with user-defined securities, do the following:
1. From the Securities section, click New User-Defined Securities.

: File : E=Edit Definition Master : Search for ~ Go
;| B Send us feedback
Portfolio
~8 Portfolios i Action| B save {4} Export~ EyPrint| [ Post @ Help
E Mew Portfolios (0/0) r Status  Security Name Ticker Security ID Morningstar  Price
E Existing Portfolios (0/1) Mappad
_ Sacurity Type
H Fositions (18)
& Prices (0/0) r m iShares STOXX Global Sel Div 10C DEQOOADFSUH Other Impe
~ &5 Securities
B Morningstar-tracked Securities (0/7,
E Mew User-Defined Securities (1/1)
= Existing User-Defined Securities (0/1)
< >
Al # A B E€DEFGHTIIEKLMNOPQQRSTUWVWIXVY Z
S > | Total: 1 &y selected: 0
Import Interface: Model Portfolio Holdings

The iShares STOXX Global ETF is flagged in red with a warning sign.

When importing stocks and ETFs, you will be prompted to map the exchange for that

particular investment. Once done, this will be mapped in Security Definition Master and

you will not be required to do this again for this Model Portfolio.

2. Double-click on the red warning sign. The Select the matching security window
opens.

< Note: The Representative Performance Stream column identifies the primary
listing for this ETF.

3. Select the primary class, indicated by a Yes under the Representative Performance
Stream column.

< Note: If you click Save as User-Defined, this will be saved in Definition Master
and the system will remember this information during the next import for this model
portfolio.

4. Click OK.

Select the matching security here

Multiple matchings have been found for the following securities. Select the proper security to be matched and cick on “OK™, or
Click on ™Save As User Defined™ to reate as user defined security if @ proper matching is not found.

Exercise 11: Mapping
Securities

Morningstar | Morningstar Mapped MSSecld Security Type | Security ID | Currency Stat Representative |[Exchangs Name @
Ticker Mame Perfermance
Stream
1 |15PA iShares STOXX Global | OPODOOM7SU | ETF D38039109 | EUR ‘Active No [DEUTSCHE BOERSE AG
[]2 |SDGPEX |iShares STOXX Global |0POOO17T4T | ETF D38039109 | EUR Active No SWISS EXCHANGE
3 |[1SPA iShares STOXX Global | FOD000SGVD | ETF D38039109 | EUR Active Yes [DEUTSCHER KASSENVERE

© 2020 Morningstar. All Rights Reserved.



Constructing a Model Portfolio

Exercise 12: Mapping Securities

5. Click Save.

A prompt confirms the changes were saved, and there is no more warning under New

User-Defined Securities on the left navigation panel.
6.  From the toolbar, click Post.

7. When prompted, click 0K and close the Import window by clicking on the red cross in

the top-right corner.

You are taken back to the Model Portfolios section.

Open your portfolio and notice how the dates were successfully recorded.

My Portfelic Medel

File MNew Favorites Tools Reports Help Search for In This View

B Send us feedback

Model Portfolio

H General Settings Action~ | View Snapshot

» &8 Imported Price/Return

> Go

—— 16/03/2017

E Holdings Summary & tmport i} Export~ | 55 Edit Data | [E] PDF | g% Refres 51 /05/2016
r Name 15/06/2016

01/01/2016

Benchmark:MSCI Eurcpe NR EUR

Edit =

Price Source

Morningstar Price

ISIN

i AXA Rosenberg Pan-Erup Eq Alpha A EURAcc 12.50 Morningstar Price IEQL
2 BGF Global Allocation A2 15.00 Morningstar Price LUD
| ] Candriam Sust Pacific C JFY Cap 12.50 Morningstar Price BED
4 Cash EUR 5.00 Imported Price Cas
s Fidelity Special Situations 10.00 Morningstar Price GBO
MﬂHN'NGSTAH Morningstar Direct 2021 24
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Constructing a Model Portfolio Appendix A: Tips when Importing ETFs and Stocks

Stocks and ETFs are listed on multiple exchanges in the Morningstar Database. Appendix A: Tips when

When importing this type of investments using ISIN, you will be prompted to select the Importing ETFS and Stocks

right exchange during the import process, as seen in Exercise 9: Mapping Securities.

Morningstar Direct offers a couple of options to deal with situation when importing
Model Portfolios:

» Use Secld as identifier during import: an ETF/Stock listed on multiple
exchanges will have a different Secld depending on the exchange it's listed
on. By using the Secld as identifier for the ETF/Stock on the specific exchange
you require in your import file, Morningstar Direct will automatically select the
appropriate exchange.

Date  Portfolio Name Portfolio ID  Identifier Holdings Weight
(%)

21/09/2016| My Paortfolio Portfolio123 |IEOD0B365730 |AXA Rosenberg Pan-Eurp EQ Alp AEUR | 15.00
21/09/2016(My Portfolio Portfolio123 [LUD171283459 |BGF Global Allocation A2 750
21/09/2016| My Paortfolio Portfolio123 |BED174191768 |Candriam Sust Pacific C Acc 15.00
21/09/2016(My Portfolio Portfolio123 |GBOD03875100 |Fidelity Special Situations 10.00
21/09/2016|My Portfolio Portfolio123 [LU1240328812 |Invesco Euro Equity A EUR Acc 1250
21/09/2016| My Portfolio Portfolio123 |LUD194781224 |Invesco European Growth Equity E 1250
21/09/2016(My Portfolio Portfolio123 [FO0D0005GVD  |iShares STOXX Global Sel Div 100 (DE) 12.50
21/09/2016(My Portfolio Portfolio123 LU00B5136942 |Robeco High Yield Bonds DH EUR 7.50
21/09/2016|My Portfolio Portfolio123 |Cash EUR Cash EUR 7.50
16/03/2017| My Portfolio Portfolio123 |IE000B365730 |AXA Rosenberg Pan-Eurp EQ Alp AEUR | 1250
16/03/2017| My Portfolio Portfolio123 [LUD171283459 |BGF Global Allocation A2 15.00
16/03/2017| My Portfolio Portfolio123 |BED174191768 |Candriam Sust Pacific C Acc 1250
16/03/2017| My Portiolio Portfolio123 |GBOD0D3875100 |Fidelity Special Situations 10.00
16/03/2017| My Portfolio Portfolio123 |LU1240328812 |Invesco Euro Equity A EUR Acc 10.00
16/03/2017| My Portfolio Portfolio123 |LUD194781224 |Invesco European Growth Equity E 15.00
16/03/2017| My Portfolio Portfolio123 [FOD0005GVD  |iShares STOXX Global Sel Div 100 (DE) 12.50
16/03/2017| My Portiolio Portfolio123 LUO0B5136942 |Robeco High Yield Bonds DH EUR 7.50
16/03/2017| My Portfolio Portfolio123 |Cash EUR Cash EUR 5.00

» Use the ETF/Stock listed on the primary exchange. There is an option you can
select to automate this process:

1. Go to File > Set User Preferences > Import tab.
2. Select the checkbox for Auto-Select Representative Performance Stream
Investments.

This option will automatically select ETFs and Stocks on their primary listing
when importing Model Portfolios.

MAORNINGSTAR Morningstar Direct 2021 25
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Constructing a Model Portfolio

» Another option is to apply filters for Exchanges and Currencies when running

an import.

When importing a model portfolio with ETFs/Stocks on various exchanges, you can
assign a preferred order in your exchange and currency selection.

To use this function, do the following:

1

2.
3.
4

Go to File > Set User Preferences > Import tab.

Under the Choose your investment matching filter settings, click Set Exchange Filter.

Click Add/Remove Exchanges.

As an example, select the following exchanges:
o Euronext Paris S.A., FRA

o Euronext Amsterdam, NLD

o  Borse Berlin — Freiverkehr, DEU

Select Import Match.

Set Exchange Filter

Our system will attempt to map your imported securities to Morningstar-tracked securities. You can configure the security
matching process by selecting the exchanges where your securities are trading below. The process will pick the first match from
the selected exchange list according to your selected order.

Use selected countries fexchanges/currendies as default for security matching. Rearder by going to 'Add/Remove' dialog box.

Selection Import | *
Order Exchange Code Exchange Name Match
1 EXSSESXPAR EURONEXT PARIS S5.A. FRA
2 EXSSSSXAMS EURONEXT AMSTERDAM,NLD
EXSSSEHERB BORSE BERLIN - FRENERKHER, DEU

Help Add /Remove Exchanges Save + Close Cancel

By setting up those filter options, any ETFs/Stocks listed on those exchanges will be
mapped to them during import, in order of preference.

You could apply a similar mapping by currencies, which can be useful for multi-
currency open-end funds sharing the same ISIN.

Appendix A: Tips when Importing ETFs and Stocks

MOHMNBSTAH Morningstar Direct 2021

© 2020 Morningstar. All Rights Reserved.

26



Constructing a Model Portfolio

Appendix B: Using Combined Series

A Combined Series option exists for Accounts, Model Portfolios and Custom
Benchmarks, but this tends to be more used for Custom Benchmarks.

Combined Series deal with manipulating return series rather than having holdings with
different weights or market values like a traditional model.

The Combined Series options are as follows:

» Arithmetic Addition/Subtraction: add or subtract the returns of two series
(usually used for combining indexes). For example, the S&P 500 returns 12% and
the US Agg returns 2%. The combined series of these two would show a return
of 14%.

» Geometric Addition/Subtraction: same as the above except that it takes
compounding into account.

» Arithmetic Addition/Subtraction of a Constant: take a base series (usually an
index) and add or subtract a constant value. This can be applied daily, monthly,

quarterly, semi-annually or annually. For example, Euribor 3 Months returns +/-
2%.

» Geometric Addition/Subtraction of a Constant: same as the above except that it
takes compounding into account.

» Currency Hedging: using derivatives to eliminate (hedge away) the risk of
currency rates changing.

@ Note: Important side note: Combined Series models cannot be added as a holding in
another model. For weighted blends, you would create a non-combined series model
and add the two underlying models as holdings, weighting them, for example, at 60%
and 40%.

As an example, we will create an addition of 2% annually to a risk-free rate. Do the
following:

1. From the Portfolio management module, click Custom Benchmarks.

2. Click New. The Benchmark Basics window opens.

3. Inthe Name field, type “Euribor +2%".

4. Under Combined Series, click the Yes radio button to activate this function.

< Note: As you activate this function, all options under the Combined Series: No
section are greyed out.

5. Under Base Series, click the magnifying glass. The Select Series window opens.

6. In the Find By search field, type “Euribor 3 m” (or any other risk-free name of your
choice).

1. Click Go.

8. Select Euribor 3 Month EUR.

9. Click OK. You are returned to the Benchmark Basics window.

Appendix B: Using
Combined Series

MﬂHNlNBSTAFI Morningstar Direct 2021

© 2020 Morningstar. All Rights Reserved.

2]



Constructing a Model Portfolio Appendix B: Using Combined Series

10. Using the Operator drop-down menu, select Arithmetic addition of a constant. The
Constant % field appears.

11. In the Content % field, type 2.

12. Using the Per drop-down menu, select Annually.

Benchmark Basics

Enter general benchmark information here.

Combined series O No

Combined series:Yes

Base series Euribor 3 Month EUR

<P

Select options as

Operator Arithmetic addition of a constant shown here

Constant % 2.00

Per Annually

<

Combined series:No

Currency

Benchmark 1

Benchmark 2

o

Risk free proxy
Portfolio ID

Performance source A

Save Cancel Help

13. Click Save.

You have now created a custom benchmark composed of a risk-free rate +2% annually.
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